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Unit 1: 
Orientation to BOCES SAMS 

 

 

 

1.1 Unit Overview 
 

The BOCES State Aid Management System (SAMS) is an ancillary system of the State Aid Management System 
that facilitates the collection and processing of BOCES Financial and CoSer data that is required by the New 
York State Education Department (NYSED). BOCES SAMS is accessible to authorized users from each BOCES, 
staff from the State Aid unit of the Education Department, and other authorized users from various state 
agencies. 

 

In this unit, you will learn how to log in and out of BOCES SAMS.  An overview of the header and menu 
options will also be provided in this unit. 
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1.2 Logging In and Out of BOCES SAMS 
 

1.2.1 Synopsis 
 

BOCES SAMS is accessed by logging into the State Aid Management System. SAMS is an Internet-based 
application allowing users to enter and retrieve information from any computer with an Internet connection 
and Google Chrome or Mozilla FireFox. SAMS users login to the application through the NYSED’s Application 
Portal and Single Sign-On (SSO) facilities.  

 

The Application Portal (portal.nysed.gov) is the entry point into all NYSED Internet applications. All NYSED 
applications you are authorized to access are accessible from this page. Some applications, such as SAMS, 
require user name and password authentication. NYSED’s Single Sign-On service, accessible from the Portal 
page, prompts you for your user name and password and then decides which applications, like SAMS, you are 
authorized to use.  

 

Each BOCES controls staff access of its staff members to SAMS and the BOCES financial data contained in it. 
BOCES users should obtain user names and passwords from an individual at the BOCES that already has been 
designated by the district superintendent to perform this function (the delegated administrator).  

 

You may wish to visit http://www.p12.nysed.gov/seddas/seddashome.html for more information. Check out 
the FAQ section under the Training Materials link. 

  

http://www.p12.nysed.gov/seddas/seddashome.html
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For easy reference, you may wish to record below the name and contact information of individual(s) at your 
BOCES that can assist you with SAMS login and password questions/problems: 

 

Name: ________________________________________________ 

 

Phone: ________________   E-mail: _______________________ 

 

Name: ________________________________________________ 

 

Phone: ________________   E-mail: _______________________  
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1.2.2 Logging in  
 

Establish an internet connection in order to run the SAMS application: 

 

1. You access SAMS through the New York State Education Department Application Portal at 
http://portal.nysed.gov.  

 

 

 

 

2. After the Portal page appears, click on the ‘Log On’ menu option in the upper right hand side of the 
page. 

 

3. The Single Sign-On dialog box appears.  

http://portal.nysed.gov/
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4. You are prompted to enter a valid Username and Password in the two text boxes provided. Both the 
Username and Password should have been previously setup for you. If this has not occurred, 
please contact the Delegated Administrator (DA) at your BOCES. If you want to change your 
password to SAMS and any other NYSED applications you are authorized to access from the 
NYSED Portal, select the ‘Change Password’ menu option on the upper right hand side of the 
Portal page. 

 

5. Find the ‘My Applications’ tab on the page and click on the ‘State Aid Management System 
(SAMS)’ hyperlink.  The SAMS Homepage will appear. If for some reason, your User Name and 
Password are not associated with the SAMS application, you will not find SAMS in the ‘My 
Applications’ tab of the Portal Page. If this occurs, contact your Superintendent. 

 

6. Click the BOCES SAMS link to access the BOCES SAMS Subsystem.  
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Important Information: If you enter an invalid User Name or Password, Single Sign-On will return the 
following error message- ‘Error: Authentication failed. Please try again.’  If you forgot your User Name or 
Password, you must contact your BOCES District Superintendent.  
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1.2.3 System Roles  
 

Your User Name is tied to a system role. Your system role determines what you can and cannot 
do on the system, including which BOCES you have access to. Users that are associated with a 
single BOCES will only have access to their BOCES’ data. A system role is assigned to you at 
the same time your User Name and Password are registered in the Single Sign-On directory. 
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1.2.4 Logging out 
 

Click on Logout from the BOCES SAMS menu bar.  You will find it located on the upper right side 
of any BOCES SAMS page.  

 

 

 

After clicking on Logout, you will be redirected to the portal home screen where you will click the 
Logout button. This will redirect you back to the NYSED Portal Application. 
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1.2.5 Session Timeout 
 

BOCES SAMS is an online, Web-based application. When you log on to BOCES SAMS, the system establishes a 
‘session id’ for your visit and each time you go through the log on process you are assigned a unique ‘session 
id’.  

 

New York State information security standards mandate that all online applications have a session timeout 
set. For the BOCES SAMS subsystem, the established session timeout is eight (8) hours. This means that if you 
log on to the BOCES SAMS subsystem and there is no activity detected by the application in any consecutive 
eight-hour period, your session will be terminated. If session termination occurs, any work you’ve done on 
the system during the past eight-hours could be lost. 

 

It is important to understand that BOCES SAMS can only detect activity when you exchange information with 
the Web server. Therefore, if you are adding comments to a BOCES edit report, enter some comments, and 
walk away from the application for eight hours, your comments will be lost if you did not save before the 
session timeout occurred. 
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1.2.6 Summary 
 

BOCES SAMS Login and Logout are simple processes to follow. To Login to BOCES SAMS, the user must have a 
valid User Name and Password that has been previously registered with the Single Sign-On directory. For 
security reasons, you should remember to always logout of BOCES SAMS if you are leaving the area of your 
computer for an extended period of time. 

 

If any problems are encountered during the login process, please contact the Delegated Administrator at 
your BOCES for assistance. 
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1.3 Header and Menu Bar Options 
 

1.3.1 Synopsis 
 

BOCES SAMS has a single header and menu bar that is accessible from any BOCES SAMS page.  Users may 
move through any function in the application regardless of where they are working and quickly navigate to 
other areas of the application.  
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1.3.2 Header Description 
 

The BOCES SAMS header is used to view and set the BOCES’ context. The BOCES SAMS header includes fields 
for a BOCES Name, BEDS Code, and a Claim Year.  

 

“Claim year” corresponds best to “Aid year.” For example, to claim 2019-20 BOCES Aid and provide expense 
data for 2020-21 BOCES Aid, you will select the 2019-20 claim year in the header area. However, to enter 
2019-20 school year CoSer information into the SAMS Co-Ser system, the 2020-21 claim year must be 
selected. 

 

For users who have a role that assigns them to just one BOCES, both the BOCES Name and BEDS Code fields 
are read-only. Just the Claim Year can be selected and changed for these users. For users that have access to 
multiple BOCES, the Name, BEDS Code, and Claim Year fields can be accessed and changed. Whenever a 
change is made to header information in these fields the user must click on the Set Values button to invoke 
the change. 

 

It is very important to check the header and ensure that data is being imported, or in the case of the CoSer 
system, entered into the correct claim year. 

 

 



BOCES SAMS Training Manual for BOCES Users (Updated April 2020) 

Page 18 of 103 

1.3.3 Menu Bar Options  
 

Entity Info 
This menu bar option provides access to data stored in another NYSED information system called SEDREF.  
This system contains extensive demographic information about BOCES that interact with NYSED. The Entity 
Info page in SAMS displays SEDREF information associated with the current BOCES set in the SAMS header. 
Information includes basic BOCES attributes, such as BOCES code, BOCES code, BOCES Type, BOCES District 
Superintendent and RIC Code. Key contacts associated with the BOCES are also listed and authorized users 
can edit the information for these BOCES SAMS contacts. 

 

BOCES Financial  
This menu bar option provides access to the BOCES financial data collection forms. The BOCES financial menu 
option has three main submenu options, State Aid Forms, State Aid Reports, and BOCES XML Import. To 
support the form selection process a Form Tree is provided that divides the forms into form sets. Each form 
set is a sub-folder on the Form tree and all forms associated with a form set are associated with the folder. 
The State Aid forms submenu option has two submenus, BOCES Official Data and BOCES Revision Data. 

 

The BOCES Official Data and BOCES Revision Data options represent data areas in BOCES SAMS. The BOCES 
Official Data area always holds the official BOCES financial data as it exists in the system. The BOCES Revision 
Data area holds updates or edits to the official BOCES financial data area when a BOCES needs to revise their 
official submittal.  

 

The State Aid Reports submenu option provides access to various reports associated with the BOCES 
Financial data in the application.  

 

The BOCES XML Import submenu option allows the BOCES to electronically load data into BOCES SAMS from 
a file import process.  

 

CoSer System  
This menu bar option provides access to the CoSer System’s data collection forms and reports. The CoSer 
System menu option has the two main submenu options, CoSer Forms and CoSer Reports.  To support the 
form selection process a Form Tree is provided that divides the forms into form sets. Each form set is a sub-
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folder on the Form tree and all forms associated with a form set are associated with the folder. The CoSer 
Forms sub- menu item has two submenus, CoSer Official Data and CoSer Revision Data. The CoSer Reports 
submenu option has the following submenus; CoSer Approval Status Report, CoSer Revenue Report, CoSer 
Contract Report, CoSer Service Description Status Report, and CoSer Description Status History Report.  

 

The CoSer Official Data and CoSer Revision Data options represent data areas in BOCES SAMS. The Official 
Data area always holds the official CoSer data as it exists in the system. The Revision Data area holds updates 
or edits to the official CoSer data area when a BOCES needs to revise their official submittal.  

 

PLEASE NOTE: ANY INFORMATION ON THE COSER SYSTEM IS 
REVIEWED BY THE OFFICE OF EDUCATION MANAGEMENT 

SERVICES. THE OFFICE OF STATE AID DOES NOT REVIEW THE 
INFORMATION ENTERED INTO THE COSER SYSTEM. IF YOU HAVE 
ANY QUESTIONS ABOUT THE COSER SYSTEM PLEASE CONTACT 

EDUCATION MANAGEMENT SERVICES. 

 

Claim Verifications  
The Claim Verification (CV) process occurs annually for items that the Office of State Aid are asking more 
information about. This may be to increase the departments understanding of a certain Activity or reporting 
of an item; also, it may require additional information about the state aid claim. The CV may include one or 
more projects that the BOCES would be required to participate in. 

This menu bar option provides access to all screens related to the Claim Verification process. This includes 
the Claim Verification Project List, Claim Verification Activity Log, Claim Verification Reports, and Claim 
Verification Notifications.  

 

 

Activity Log 
This menu bar option provides access to the BOCES SAMS Activity Log. The Activity Log captures all status 
changes of all form sets for a given BOCES. Users can review the Activity Log to see when key milestone 
events occurred related to a given form set. For example, the Activity Log can be used to see when a given 
form set was "Certified". The Activity Log also tracks notification events, which are typically  emails sent by 
BOCES SAMS when a certain event trigger occurs.  
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Home 
This menu bar item brings you back to the BOCES SAMS home page. 

 

Issue Reporting 
This menu bar item launches the users default email application and pre-populates an email to the 
OMSSAMS mailbox with a standard template for reporting issues. Please use this menu bar choice to report 
any BOCES SAMS questions or problems. 

 

Help 
The BOCES SAMS Online Help module for the application provides information on all features. 

 

Logout 
This option is used to exit the BOCES SAMS application.  Once selected, you will be directed to the Single 
Sign-Off page.  See the Logging Out section for important details on logging off correctly. 
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1.3.4 Summary 
 

The BOCES SAMS header and menu bar is available from all pages within the application. The content of the 
menu bar is determined by a user’s security access role. All users will not see the same options on the menu 
bar. If there are functions available and you do not have access to them but believe you should have access, 
please send an email to OMSSAMS@mail.nysed.gov. 
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Unit 2: 
Importing Data in BOCES SAMS 

 

2.1 Unit Overview  
 

BOCES Financial Data must be imported into BOCES SAMS using a pre-defined XML file format. The XML file is 
the only mechanism that a BOCES can use to submit BOCES Financial Data into BOCES SAMS.  

 

In this unit you will learn how to import an XML file into BOCES SAMS, how to import your file to the correct 
data area and how to determine if your file was imported successfully. This unit will also explain how 
revisions to the XML file will be handled.  
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2.2 Importing an XML File.  
 

To import an XML file into BOCES SAMS, perform the following steps:  

 

1. From the BOCES SAMS main menu, run your mouse over the BOCES Financial option.   

 

2. Click on the BOCES XML Import sub-menu option.  

 

 

 

 

 

3. Select the Data Area into which your file should be imported. Note: You will only choose the Official 
data area for imports you perform before the Distict Superintendent (DS) has certified your form set. 
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4. Click on the Browse button.  A new window will open that allows you to select the XML file from a 
location on your computer. Select the file name and click Open.  

 

5.   Click on the Import Button on the Bottom of the screen.  Importing XML data files into the BOCES 
SAMS system is a very processor and database intensive operation.  It may take as long as 5 to 10 
minutes after you click on the Import Button before you see the results of the import on the screen.  
Please be patient during this process.  SED is working to improve the speed of the import process but 
such refinements may not be immediately available.  

 

6.  Confirm that the import was successful by reviewing the Import Results on the bottom of the screen.  

 

7.   Resolve any import validation errors displayed at the bottom of the screen and return to Step 1 
above to begin the import process again.2.3 About Data Areas.  

 

Data Areas are used to logically separate data that is stored in the centralized BOCES SAMS database.  There 
are two data areas in BOCES SAMS, the Official Data Area and the Revision Data Area.  
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The Official Data Area contains all of the BOCES data that was imported into the Official Data Area of BOCES 
SAMS and all changes to the data that have been accepted by NYSED.  The data in the Official Data Area is 
used for aid calculations and official reports.  A BOCES’ XML file should be imported into the Official Data 
Area any time before the BOCES District Superintendent certifies the data.  

 

The Revision Data Area contains all of the BOCES data that has been imported into the Revision data area. 
The revision data area is used to submit changes to the data set after it has been certified by the BOCES 
District Superintendent, and to review those changes prior to submitting them to SED. Once changes to the 
data are accepted by NYSED, the revised data is incorporated into Official Data Area. A BOCES’ XML file 
should be imported into the Revision Data Area after the data has been certified by the BOCES District 
Superintendent.  
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2.3 Reviewing Import Results  
 

The data that is included in the XML file will be validated when it is imported into BOCES SAMS. The results of 
the import will display on the bottom of the Electronic XML Data File Import Screen. 

 

Each section of the XML import file is processed separately.  

 

If the data in any section of the XML file passes all of the validations, the BOCES will be presented with a 
message that the import was successful. The data that was included in the XML file will display in the BOCES 
Financial forms in the Data Area that was selected for the import. We will discuss how to review imported 
data on the BOCES Financial forms in the next unit.  

 

If a data record in the XML file fails any of the validations, information about what caused the data to fail to 
import will display on the bottom of the screen.  Only records that pass all validation rules in that section will 
be successfully imported.  BOCES must resubmit their entire XML file once the necessary changes have been 
made.  

 

Validation errors are not the same as edit exceptions. Validation errors identify problems with the format of 
data (e.g., a data item submitted as two decimals that is defined in SAMS as having no decimals) and with the 
various codes used to identify data (e.g., data records submitted with an activity code that does not exist on 
the criteria guidelines) 

 

Since each record in the import file is validated, it is possible that the use of one invalid account or activity 
code will result in many validation error messages. Likewise, correcting a single invalid code will often resolve 
many issues that appeared on the original Import Screen.   

 

On the next page is an example of how the import results will display on the screen.  
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2.4 Example of Import Results    
 
SAMS has returned the following warnings. 
All Records loaded except those listed below.  

 

GLOBAL 

BEDSCODE: XXXXXX YEAR: 2019-20 

 

If your report receives a CRITICAL error, no data was loaded for that portion of the XML file and please 
report this to the developer ASAP. 

 

If your report has ERRORS, the elements with the errors were not loaded because of a problem with your 
XML file, please fix the problem and then resubmit the file. 

 

BOC_SCHED4 

ELEMENT: BOC_SCHED4_DATA, FIELD: account_code, MESSAGE: Account Code 1000 not valid 

ELEMENT: BOC_SCHED4_DATA, FIELD: account_code, MESSAGE: Account Code 1000 not valid 

BOC_SCHED4_DATA 

F-PSN-ACCT-OBJ      Actual           Projected   Error 

A-105-3960-150      125192 198551  PSN 105+Activity 3004 not on LAS 

A-105-3960-160       0 55866 Activity 4201 not on Cross Contract  

BOCES (509000) LAS. 

 

A-385-4660-490       2866                  0 Activity 6817 not on Cross Contract BOCES 
(489000) 

A-525-6211-490        0 3293 Duplicate Object Codes for the same  

Fund Code-PSN-Account are not allowed. 

 

BOC_SCHED4_REV 
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F-PSN-REV                 Actual           Projected  Error 

A-001-2252 0 0 Schedule 4 revenue codes 2252, 2253, and  

2254 cannot be  used for PSN 001 

 [ Activity: 1000 Revenue: 2252] 

 

BOC_SCHED5 

**Schedule 5 Data Successfully Imported** 

 

You may need to take different actions to address different validation errors. Below is a list of some common 
potential validation errors, and the possible actions that could address each problem: 

 

PSN /Activity code combination not 
found on LAS 

Change the code to one that appears on the LAS, or revise the LAS  

Purchaser PSN for cross contracted 
service not found on bottom portion 
of purchaser cross contract form 

Change the code, add the purchaser PSN if the service appears on 
the bottom portion of the cross contract form or if it does not 
appear, request that the provider BOCES enter the service on the 
top portion of its cross contract form  

Account code not found on system 
table of GAAP codes 

Change the code if incorrect or contact SED 

Missing activity code, or another 
required code 

Add the required code; every record must be identified with 
certain codes to be allowed into the SAMS database. 

 

 

  

Important information: Contact SED if you are unable to resolve all validation errors. Remaining 
validation errors means that the associated data has not been included in your State aid claim. 
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2.5 Importing an Updated XML File  
 

BOCES may import updated versions of the XML file into BOCES SAMS at any time. BOCES must resubmit 
their entire XML file whenever they make a change to any item within the XML file.  Data in the updated 
version of the XML file will override all of the data imported from the previous version of the XML file.  

 

Important information: If a BOCES wants to delete a record that was already imported into BOCES 
SAMS, the BOCES must enter a zero for the record in an updated version of the XML file and import the 
file into BOCES SAMS.  



BOCES SAMS Training Manual for BOCES Users (Updated April 2020) 

Page 30 of 103 

2.6 Converting XML to XLS Spreadsheets 
 

SED has developed a Microsoft Excel “template” that allows users to convert the contents of  BOCES XML 
data files into spreadsheet format.  This technique is useful for verifying the data to be imported into SAMS.    
The resulting spreadsheet contains the data as it was generated from your own accounting system – not 
necessarily what was successfully imported into SAMS. 

 

You can download SED’s template from the State Aid Website at: https://stateaid.nysed.gov/ 

and select “SAMS”,  “Training Material,”, and click on “Template for converting XML files to EXCEL” 

 

Once the spreadsheet is open just save it to your PC and name it BO xxxxxx mmddyy V9.XLS  (or whatever 
you prefer). 

 

To create an Excel version of your XML data file follow the steps below: 

 

1. Create a new XML file from your financial data system 

  

2. Save the XML file to your PC 

 

3. Open your most recent BO xxxxxx mmddyy V9.XLS spreadsheet 

 

4. Choose Data, XML, Import from the top menu 

 

5. Select the file saved in step 2 above and click Import 

 

6. Choose File, Save As, and save your spreadsheet with a meaningful name * 

 

7. After you have completed importing the data into SAMS we suggest that you copy and paste the 
Import Validation Error Report (which SAMS emails to the user) into the second tab of this template. 

https://stateaid.nysed.gov/
https://stateaid.nysed.gov/sams/xls_docs/BO%20xxxxxx%20mmddyy%20V9.xls
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8. Save your file again. 

 

* SED would prefer that you use a naming convention that contains at least your BOCES six digit BEDS Code 
and our XML schema definition version number V6. The date that your data was imported to SAMS is also 
helpful. For example BO 123456 100211 V6.xls 

 

 

Please note:   the speadsheet template and our instructions were developed 
using Microsoft Excel Verion 2003.  They may require adjustments (and possibly 
the installation of “add-ons” to Excel) to work correctly using newer versions of 

Excel. 
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Unit 3: 
Reviewing Imported Data on the BOCES Financial 

Forms 
 

 

 

3.1 Unit Overview 
 

 

To ensure the accuracy of the State Aid claim, it is critical for BOCES to carefully review the data that has 
been imported into SAMS. 

 

BOCES’ can review the data they import into BOCES SAMS using the BOCES Financial Forms.  SAMS is 
designed to hold multiple claim years of State Aid and, therefore, supports a library of forms for each claim 
year. BOCES SAMS allows you to specify a claim year of interest and then it retrieves all the forms associated 
with that claim year and any data related to your BOCES.  

 

In this unit, you will learn how to select a form, review the data on a form, and print a form.  
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3.2 Opening and Reviewing a BOCES Financial Form  
 

To open a BOCES Financial Form follow these steps: 

 

1. Look at the BOCES SAMS header. The BOCES Name should be set to your BOCES, as should the 
BEDS Code. Both of these settings are read-only for BOCES users. The Claim Year, by default, 
should be set to the current claim year when you first logon. This setting can be changed by you to the 
desired claim year. This is the only setting BOCES users can change in the header. Select a claim 
year from the drop-down options and click on the Set Values button. A message will appear 
confirming your selection. 

 

2. From the BOCES SAMS main menu, run your mouse over the BOCES Financial option, and the 
State Aid Forms menu options.  Click on either the BOCES Official Data sub-menu option or the 
BOCES Revision Data submenu option depending on what data you want to review.  
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3. BOCES SAMS returns the Form Tree for the Data Area that was selected. Open a menu folder by 
clicking on the plus sign (+) next to the folder or on the name of the folder.  The form selection tree 
expands the folder to reveal its subcomponents.  The subcomponents of a menu folder include a 
listing of the forms and schedules contained within it.  An expanded folder can be collapsed by 
clicking on the minus sign (-) next to it or on the name of the folder. 

 

 

 

4. The status of each of the forms and schedules within the opened folder is displayed next to their 
name on the form selection tree (e.g. ‘Saved’).    
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5. Click on the name of the form you want to open.  A page will open that will allow you to select the 
PSN/CoSer or SED Project Number that you want to review.  

 

 

6. Add information on the LAS  A page will open that will allow you to select the PSN/CoSer or SED 
Project Number that you want to review. The PSN that is selected from the PSN drop down is 
associated with a CO-SER (PSN-Activity Code Combination) on the List of Active Services (LAS) 
for the claim year that is selected in the BOCES SAMS header. Only CO-SERs that are Active on the 
associated LAS are displayed on the list for selection. If a CO-SER is expected to display on the drop 
down, but is not displayed, please check your LAS for the associated year to confirm that the CO-
SER is an Active CO-SER. The Purchaser PSN drop down list is a list of Cross Contracted Services 
that you are receiving. The Purchaser PSN is displayed based on the Purchaser PSN field on the 
bottom section (Purchased Cross Contracts) of the Cross Contract form in the CO-SER System. If a 
Purchaser PSN is not displayed on the drop down list, confirm that the Cross Contract has a Purchaser 
PSN listed in the associated field on the Cross Contract form. The SED Project Number dropdown 
currently only displays the SED Project Numbers that are imported via your XML File.  

 

 

 7.   Begin typing the first number of the PSN/CoSer or SED Project Number in the Type PSN, Type 
Purchaser PSN, or Type SED Project Number box. Select the PSN you want from the dropdown list. 
Click the Submit button.  
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8,  Once a PSN/CoSer or SED Project Number is selected, the form will open for the entity and claim 
year that has been set in the top left-hand corner of the application.  To review the forms associated with a 
different claim year, select a year from the Claim Year box located in the top-left corner of the 
application and click the Set Values button. 

 

9,  To change the PSN/CoSer that you are reviewing, click on the Change PSN, Change CoSer, or 
Change Project link on the top of the form. A new window will open that will allow you to select a 
different PSN/CoSer or SED Project Number to review. Begin typing the first number of the PSN/CoSer 
or SED Project Number in the Type PSN, Type Purchaser PSN, or SED Project Number box. Click 
on the Submit button and the form will reload.  

 

10.  To view a different form for the same PSN you are reviewing repeat steps 1 through 5 above.  The 
form that you click on will open with data for the PSN that you are reviewing.  

 

 

 

 

Important Information: Always make sure you have set the appropriate claim year before accessing form 
data. 
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3.3 Printing a Form 

3.3.1 Printing a Form with Data 
 

The following steps explain how to print a form with data: 

 

1. Open the form you want to print. 

 

2. Select the Print Form link located in the top right corner of the form.  A new window will open 
displaying a ‘printer friendly’ version of the form. . If a new window does not open when you click 
on Print Form, your internet browser probably has the “Pop Up Blocker” on. To fix this,   go to the 
tools menu for your browser, click on Pop Up Blocker, click on settings, and set your browser to 
allow Pop Ups from BOCES SAMS. 

 

 

 

NOTE:  The Print Text Only link may also be available in the top right corner of the form.  This 
print option is similar to the Print Form option, except the input boxes that surround each data field 
are removed from the printed form. 

 

3. From the File menu of the new window, click Print.  A new print options window will open  
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4. Set the printing options you want and click the Print button. 
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Important Information: BOCES SAMS will open a new browser window under a few circumstances; 
e.g., print forms and display comments. To close these additional browser windows, you must click on 
the ‘X’ box in the upper right hand corner of the browser window or by pressing ‘CTRL+W’. 

  



BOCES SAMS Training Manual for BOCES Users (Updated April 2020) 

Page 40 of 103 

3.3.2 Printing a Selected Part of a Form 
The following steps explain how to print a selected part of a form: 

1. Open the form you want to print. 

 

2. Select either the Print Form link located in the top right corner of the form, depending on whether or 
not you want to print the form with data.  A new window will open displaying a ‘printer friendly’ 
version of the form. If a new window does not open when you click on Print Form, your internet 
browser probably has the “Pop Up Blocker” on. To fix this,   go to the tools menu for your browser, 
click on Pop Up Blocker, click on settings, and set your browser to allow Pop Ups from BOCES 
SAMS.  

 

3. Hold the left mouse button down and drag the cursor over the portion of the form that you want to 
select for printing. 
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4. From the File menu of the new window, click Print.  A new print options window will open. 

 

 

 

5. In the Page Range section of the General tab, choose the Selection option.  If this option is not 
available or selectable, then you have not selected a portion of the form to print (see step 3). 

 

6. Set the other printing options you want and click the Print button. 

 

 

Important Information: BOCES SAMS will open a new browser window under a few circumstances; 
e.g., print forms and display comments. To close these additional browser windows, you must click on 
the ‘X’ box in the upper right hand corner of the browser window (or press ‘CTRL+W’). 
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Unit 4: 
Getting and Using Help 

 

 

 

4.1 Unit Overview 
 

Help is an important feature of any application.  The help files for BOCES SAMS can be accessed from 
anywhere within the application. BOCES SAMS help is context sensitive and can provide users with a built-in 
table of contents, index, search facility, and glossary. 
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4.2 Accessing Help 
 

Click the Help link located near the top-right corner of the application to access help.  A separate window 
containing all of the help content for BOCES SAMS will appear.  Pressing the F2 function key is a keyboard 
shortcut that will also launch the BOCES SAMS help window.  The F1 function key is reserved for the help 
content of the browser being used to display the BOCES SAMS application. 

 

 

To scroll through a table of contents for help, click the Contents tab.  When you want to find specific 
keywords, click the Index tab and type your word(s) in the designated box.  A Search tab is available to search 
for topics that contain references to the word(s) you enter in the search box.  Definitions for common terms 
can be viewed in the Glossary tab. 
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4.3 Printing a Help Topic 
 

To print a help topic: 

 

1. From the File menu of the help window, click Print.  A new print options window will open. 

 

2. Set the printing options you want and click the Print button. 

 

 

Important Information: If everything displayed in the help window prints, including the frame on the 
left that contains the Contents tab, then change your printing options.  Under the Options tab in the 
print options window, select the option to print ‘Only the selected frame’ and left-click the mouse on 
the topic you want to print before printing it 
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4.4 About Context-Sensitive Help 
 

Context-sensitive help provides information relevant to the task the user is currently trying to accomplish, 
such as entering data on a form.  Where enabled, the following types of context-sensitive help are available 
in BOCES SAMS: 

 

 Form-level Help:  When the cursor is not in a particular field on a form and help is accessed, the help 
topic specific to that form is displayed. 

 

 Field-level Help:  When the cursor is in a particular field on a form and help is accessed, the help 
topic specific to that field is displayed. 
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Unit 5: 
Forms, Form Sets, and Data States 

 

 

 

5.1 Unit Overview 
 

In Unit 3- Reviewing Imported Data on the BOCES Financial Forms, an overview of how to open and review 
imported data on the BOCES Financial forms was provided. In this unit, additional information will be 
presented about the BOCES Financial forms. Information on data states and the data state indicator will be 
presented so that you gain an understanding of how your forms move through the BOCES SAMS workflow 
process.  Finally, information on how to certify your BOCES Financial data will be outlined.  
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5.2 Understanding the Status of Forms  
The BOCES Financial forms are logically grouped into two components known as ‘form sets’. All of the State 
Aid Claim forms and schedules, the State Aid edit report and the State Aid Certification Form are part of one 
form set.  The Statewide Uniform and Local Cost Basis forms, edit report  and Certification Form are part of 
the second form set. Form sets achieve various data states as they are processed through BOCES 
SAMS.  These data states are used to control system functions and workflow-type activities. They provide you 
with information about where your State Aid claim is in the approval process and whether and what further 
action on your part is needed. 

Data states apply to forms and form sets.  In addition, there are dependencies between data states that 
dictate which data state(s) can or must precede another data state before it can be achieved.   

The data state of each form and form set is displayed next to its name on the Form Selection Tree.  If the data 
state is Null, however, nothing will be displayed next to the name of the form or form set.  In addition, 
starting with the “Certified” data state, when the data state of a form set changes, the form set will appear in 
the activity log with the data state indicator next to it.  

A summary of the data states is provided in the table below.  The data states in the table are listed in the 
approximate order in which they are achieved as the forms are processed through BOCES SAMS. 

 

Status Description 

Null Represents the data state of a form before a user 
has imported any data to it.  

Saved Represents the data state of a form when a BOCES 
has successfully imported data to it.  

Valid prior data state- Null, Saved 

Ready Represents the data state of the Edit Exception 
Report when a user has finished adding and saving 
comments to it. The user must press the “Save & 
Ready” button to change the data state of the form 
to Ready. 

Valid prior data state- Null, Ready 
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Status Description 

Certified Represents the data state when the form set of a 
BOCES has been certified by the District 
Superintendent.  Certification simultaneously acts 
as the official submission of the form set data to 
NYSED.  Form sets are certified separately through 
the use of a certification form that is specific to 
each form set.  The Edit Exception Report(s) 
associated with a form set must be in the Ready 
state before the form set can be certified.  After 
certification, BOCES will have read-only access to 
their forms in the Official Data Area, but new files 
may be uploaded to the Revision Data Area as long 
as the submission is not in one of the ‘in progress’ 
data states. 

Valid prior data state- Ready 

Edit in Progress Represents the data state when NYSED begins the 
edit of a BOCES form set.  BOCES will not be able to 
import revised files into SAMS while the associated 
form set is in this data state. 

Valid prior data states- Certified, Edit Rejection, 
Corrections Submitted 

Edit Rejection Represents the data state when NYSED rejects an 
Edit Exception report of a BOCES form set during 
their edit process. may now import revised files. 

Valid prior data state- Edit in Progress 

Corrections Submitted Represents the data state when a BOCES re-
submits a form set with corrected items during the 
edit process. This data state reflects the submission 
of revised data before a form set has been 
“cleaned” for the first time by SED. 

Valid prior data state- Edit Rejection 
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Status Description 

Corrections In Progress Represents the state of the data when NYSED has 
begun reviewing a BOCES' corrections. BOCES will 
not be able to import revised files into SAMS while 
the associated form set is in this data state. 

Valid prior data state- Corrections Submitted 

Corrections Accepted Represents the data state when NYSED accepts the 
submitted corrections into the Official data area.. 

Valid prior data state- Corrections In Progress 

Corrections Rejected Represents the data state when NYSED rejects the 
corrections submitted by a BOCES.  BOCES must 
submit corrected data for the form set to be 
‘cleaned.’ 

Valid prior data state- Corrections In Progress 

Clean Represents the data state when all edit exceptions 
have been adequately explained and the edit 
process is complete.  If there are no edit exceptions 
when a form set is certified/submitted, then the 
system will automatically change the data state to 
Clean and the  edit process will be avoided. State 
Aid claim data will not be accepted into the 
Nov.15th frozen data file unless the State Aid Claim 
Form Set has reached the “Clean” or “Clean with 
Issues” data state. 

Valid prior data state- Certified, Edit in Progress, 
Corrections Accepted, Clean with Issues, Revision 
Accepted 

Clean With Issues Represents the status when there are still 
outstanding edit exceptions after the edit process, 
but NYSED wants to include this data with the 
Clean form sets for processing. 

Valid prior status- Edit in Progress, Corrections 
Accepted, Revision Accepted 
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Status Description 

Revision Submitted Represents the data state when a BOCES has 
submitted  revised data to NYSED.  Revisions refer 
to change requests made after SED has cleaned a 
form set for the first time.  Revisions will be 
reviewed for approval by NYSED before being 
accepted as official data.  Revisions not accepted by 
NYSED do not become part of the official data.  

Valid prior data state- Clean, Clean with Issues 

Revision in Progress Represents the data state after a BOCES has 
submitted their revised data and NYSED has begun 
reviewing it. BOCES will not be able to import 
revised files into SAMS while the associated form 
set is in this data state. 

Valid prior data state- Revision Submitted 

Revision Rejected Represents the data state after a BOCES has 
submitted their revised data and NYSED has 
rejected it.   

Valid prior data state- Revision in Progress 

Revision Accepted Represents the data state after a BOCES has 
submitted their revised data and NYSED has 
accepted it. 

Valid prior data state- Revision in Progress 

Revision Queued Represents the data state after a BOCES has 
submitted their revised data and NYSED has 
queued it as a Prior Year Revision. This applies only 
to revisions submitted between July 1 and June 30th 
of the year following the claim year. 

Valid prior data state- Revision Submitted 

Revision Queue Accepted Represents the data state after NYSED has 
accepted data that was previously queued as a 
Prior Year Revision. 

Valid prior data state- Revision Queued 
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Important Information: The State Aid Claim form set must achieve a status of “Clean” or “Clean with Issues” 
for the data to be included in the November 15th frozen data file. 
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5.3 Certifying Form Data 
 

Each form set has its own Certification Form that allows a BOCES to officially certify and submit their data for 
the forms and schedules associated with a form set.  The BOCES District Superintendent is the only user that 
will be assigned to a SAMS role that includes access to the Certify and Submit button in SAMS. If you do not 
have this privilege, you will not see this button. 

All forms in a form set must be substantially complete, and all edit exceptions addressed before a form set is 
certified. Before a form set can be certified, its associated Edit Exception Report must be in the Ready Data 
State.  

1. Go to the Form Tree under the Official Data Area and open the certification form for the form set 
that you want to certify from within the Official Data Area.  
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2. Click on the Certify & Submit button.  The data state of the associated form set will be changed to 
"Certified".  The forms within the certified form set will now be read-only to the school entity in the 
Official Data Area.  Any modifications to their certified data must occur in the Revision Data Area (see 
the Revising Data help topic for more information). 

 

3. Go to the activity log and verify certification / “receipt” of the form set by SED. Your form set has been 
successfully certified if the word “Certified” displays next to the form set name and the form set edit 
report. This is he only verification of claim submission you will receive. (Please note that the 
certification form on the form tree will not have the word “certified” displayed next to it; use the 
activity log only for verification purposes.) 

 

 

Important Information:  A form set cannot be certified until its associated Edit Exception Report is in the Ready 
data state. This is done by clicking on the Save and Ready button at the bottom of the edit report. To save your 
edit report comments without readying the form set for certification, click on the Save Comments button at 
the bottom of the edit report.  
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Unit 6: 
The Edit Process 

 

 

 

6.1 Unit Overview 
 

The edit process identifies potential problems with the data that is imported into BOCES SAMS. Each form set 
has its own Edit Exception Report.  When a BOCES runs an Edit Exception Report, information about any 
potential problems with the data in the form set will be displayed.  A form set’s Edit Exception Report must 
be in the “Ready” data state before the BOCES District Superintendent can certify the form set.  

 

In this unit, you will learn about the different types of edits that will appear on the Edit Exception Report and 
how to run an Edit Exception Report.    
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6.2 About Edits  
 

Edits are used to identify certain data items imported into BOCES SAMS that do not fall within certain 
expected parameters.  Edit Exception Reports alert a BOCES when there are potential problems with the data 
in a form set.  BOCES must take one of two actions when an edit exception occurs. You can either correct the 
data so that the edit exception no longer occurs when the edit report is re-run, or you may provide a 
substantive explanation in the comment area which will be reviewed by SED staff.  

 

There are several types of edits in BOCES SAMS that appear on the Edit Exception Reports; trend edits, 
proportion edits, and total check edits. Trend edits are used to identify whether an amount in BOCES SAMS 
has increased or decreased more than a certain percentage or dollar amount between the prior and actual 
year and/or the actual and projection year. Proportion edits are used to identify whether the proportional 
relationship between two items changed significantly over time; e.g, the proportion excess salaries 
constitutes of total salaries. Total Check Edits are used to identify discrepancies between BOCES wide totals 
and component allocations of the same item. 

 

Some edits are at the PSN level and some are at the major CoSer area level. In most cases, if an edit at the 
major CoSer area level displays on the edit report, you will have access to the PSN level details by clicking on 
the “View Details” link. Running the Edit Exception Reports 
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6.3 Running the Edit Exception Reports 
 

Each form set has an Edit Exception Report associated with it. Edit Exception Reports can be accessed from 
the Form Tree just like the forms. You can run an Edit Exception Report at any point. In order to certify your 
form sets, you must first run the Edit Exception Report associated with the form set and ‘Ready’ the report by 
pressing the ‘Save & Ready’ button at the bottom of each report. 

 

1. Select the Edit Exception Report you want to run from the Form Tree. 

 

2. After the Edit Exception Report page loads, click on the Run Report button to run a new report. You 
must have the default setting, ‘Run New’, set in the drop down list box. (To see previously executed 
reports, select one from the drop-down list, and click on Run Report.) 

 

 

 

3. The results of the Edit Exception Report are displayed. All exceptions that are found are listed.  The 
Edit Exception Report should be used to complete the data submission process. It identifies problem 
areas in your data before you certify and submit to State Aid.  
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Important Information: Each form set must be certified by the BOCES District Superintendent before 
they are submitted to State Aid. Before you have access to the certification process for a particular 
form set, you must ‘Ready’ the Edit Exception Report associated with that form set.  

 

 

4. To see data for the specific PSNs involved in an edit, click on “View Details.” This information will 
help you locate the source of the outlier data causing the edit exception. 

 

5. You can associate a comment with each exception occurring in the Edit Exception Report. To provide 
a comment, simply insert text in the comment text field provided with each exception generated. Each 
Edit Exception Report also has a general comment area at the bottom of the report, where you can 
associate a comment(s) with the entire report. To save comments without setting the Edit Exception 
Report to Ready, click on the Save Comments button. When you click on the Save and Ready 
button, any comments entered are automatically saved.  Comments entered for a particular edit will 
be displayed on subsequent runs of the Edit Exception Report. 
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Unit 7: 
The Revision Process 

 

 

 

7.1 Unit Overview 
 

BOCES can submit corrections and revisions to their BOCES Financial data sets after they have been certified 
and submitted to NYSED. Revisions can be submitted by importing a new version of the BOCES’ XML file into 
the Revision Data Area in BOCES SAMS. These revisions are reviewed by NYSED before they are accepted into 
the official data area.  This unit provides an overview of how this process works.  

 

As with an original data submission, users of the BOCES SAMS system must create the revision data XML file 
to be imported using their local financial system.   Users must recompile ALL AREAS of their financial data 
every time a new file is prepared.  This will ensure logical consistency in the financial data set and make 
certain that all local changes to financial data are submitted to SAMS. 

 

Information on how to prepare this data file is available from your vendor 

.  
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7.2 Submitting Revisions to BOCES Financial Data  
 

BOCES SAMS allows BOCES users to revise data that they have certified and officially submitted to NYSED.  All 
revisions must be imported into the Revision Data Area in BOCES SAMS.  Once accepted by NYSED, revision 
data is incorporated into the Official Data Area. 

 

1.   From the BOCES SAMS main menu, run your mouse over the BOCES Financial menu item and the 
BOCES XML Import sub-menu option.  
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2. Select Revision Data Area in the Data Area drop down box. 

 

3. Click on the Browse button. A new window will open that allows you to select the XML file from a 
location on your computer. Select the file name and click Open.  

 

4. Enter your e-mail address (SAMS will e-mail the Import Report to this address). 

 

5. Click on the Import Button on the Bottom of the Screen.  

 

6. Review the Import Results e-mailed to you from OMSSAMS@MAIL.NYSED.GOV  to confirm that the 
import was successful.  

 

7. From the BOCES SAMS main menu, run your mouse over the BOCES Financial menu item and the 
State Aid Forms submenu option. Select the Revision Data Area menu option.  

 

mailto:OMSSAMS@MAIL.NYSED.GOV
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8. BOCES SAMS will open the form tree for the Revision Data Area. Forms in this form tree can be 
opened and reviewed following the same steps discussed earlier in Unit 3.  

 

9. Run the Edit Exception Report. Address any edit exceptions generated by the data revisions you 
have just imported, or re-import the data if the edit exceptions are the result of inaccurate data. 

 

10. The Change Submission Summary displays how your data revisions, if submitted, will affect selected 
major areas of expense and aid. The form also gives you the ability to submit revisions to NYSED as a 
single request. The Change Submission Summary report for the BOCES Financial Form Set highlights 
changes to nine key data items.  The report compares the current Official Data Area version of the 
item to the new Revision data area item for both the actual and projected years.  Item # on this 
summary refers to the item on the listed report. After the item number, an “a” or “p” indicates 
whether the item refers to data for the actual or projected year. (At this time, please disregard the 
“school year” column on the right of the report, which is not functioning correctly and may conflict 
with the year indicated by the “a” or “p” designation.) 

 

If unexpected changes are displayed on the Change Submission Summary, the user should review 
the data carefully before submitting the revisions. 

 

11. To submit pending revisions to NYSED, press the Submit Changes button and verify successful 
submission by checking the Activity Log. The log should show “Revisions Submitted” next to the 
name of the form set which was revised.   
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11.   To clear pending revisions from the Revision Data Area, press the Clear Revisions button on the   
form.  

 

12.   NYSED will review the requested revision for acceptance into the Official Data Area.  

Revisions submitted by the BOCES do not become part of a BOCES’ official data until they are 
accepted by NYSED. 

 

 

Important Information: Your revisions have not been submitted to SED until you press the Submit 
Changes button on the bottom of the Change Submission Form. 
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Unit 8: 
The Entity Information Screen 

 

 

 

8.1 Unit Overview 
 

In this unit, you will learn about the Entity Information Screen and how it can be used to obtain pertinent 
demographic and contact information associated with your BOCES.  Information will also be presented on 
how to modify information associated with your BOCES contacts.  

 

The BOCES SAMS Entity Information Screen is linked to another information system maintained by NYSED 
called SEDREF.  This system is a central repository maintained by NYSED that contains basic contact 
information about institutions that interact with NYSED. 
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8.2 Reviewing Entity Information 
 

To review Entity Information associated with your BOCES, take these steps: 

1. Select and click Entity Info from the BOCES SAMS main menu. 

 

2.  BOCES SAMS loads the Entity Information screen and you can review all the current demographic    
information associated with your BOCES. Information presented includes your BOCES’ basic 
identifying attributes, such as BOCES Code, BOCES Name, current Superintendent, and other 
attributes. 

 

 

 

 

 

Important Information: Most of the basic demographic information presented on the Entity Information 
screen is read-only. However, you do have the ability to modify the following State Aid-related contacts 
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within BOCES SAMS: BOCES Superintendent, BOCES State Aid Designee, Board of Education Contact, 
CoSer System State Aid Designee, and the SA-111 Contact.  Information on how to do this is presented 
below. 
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8.3 Updating the Official SAMS Contacts 
 

To update a contact associated with your BOCES, take these steps: 

1. Select and click Entity Info from the BOCES SAMS main menu. 

 

2. Click on the Edit Entry button associated with the contact that you want to update. 

 

3. A new screen will be displayed that allows you edit and update the information about that contact.  
Click on the Edit Entry button after you have made your updates.  BOCES SAMS returns to the 
Entity Information screen.  The contact updates are now reflected on the screen. 
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Unit 9: 
Activity Log 

 

 

 

9.1 Unit Overview 
 

In this unit, you will learn about the Activity Log and how you can use it to review the history of activities 
associated with your BOCES’ work and how to create your own user-defined activities. 

 

BOCES SAMS automatically generates activity log records when certain events occur, such as data state 
changes and email notifications to users of the system.  An additional feature within the Activity Log allows 
users with the appropriate security role privilege to create their own activity records which can record 
information exchange events that occurred outside of the application (e.g. an email, phone call, or fax 
to/from a BOCES). 
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9.2 Reviewing the Activity Log 
 

To access the Activity Log follow these steps: 

 

1. Select and click Activity Log from the BOCES SAMS main menu. 

 

2. BOCES SAMS loads the Activity Log screen and you can review all the current activities associated with 
your BOCES.  Information associated with each activity log record, includes the activity log id, claim year, 
form set, activity type, description, date, and user.  

 

BOCES SAMS provides the ability to filter the information presented to you in the activity log. For example, 
you can choose to view only activities associated with the CoSer Form Set, or only activities associated with 
the State Aid Claim Form Set.  To filter, setup your filter preferences from the drop-down boxes provided and 
click the Apply Filter button. 

 

The results displayed in the Activity Log can also be sorted by clicking on the title of each column.  Click a 
column name once to sort by that column in Ascending order and click the same column name again to sort 
the results by that column in Descending order. 

 

The details of Correspondence items entered by SED staff, and certain other items (e.g. revision 
submissions), can be viewed in a separate browser window by clicking on the hyperlinks provided for these 
items.  
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Unit 10: 
The Claim Verification Process 

 

 

 

10.1 Unit Overview 
 

In this unit you will learn about the Claim Verification (CV) process.  This process provides NYSED with an 
online method to track the progress of various CV projects aimed at verifying the accuracy of selected claim 
data that has been submitted by BOCES.  BOCES State Aid Designee will receive an email notification when 
NYSED initiates the Claim Verification process for a given year.  This notification will identify which BOCES 
have been selected to participate in the Claim Verification process for that year, as well as, provide additional 
information about the process to the BOCES.   

 

 

 

 

Important Information: The Claim Verification menu option in not available at certain times of the claim 
period.  This menu option will be made available later in the year.  
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10.2 Access the Claim Verification Project List 
The Claim Verification Project List identifies which Claim Verification projects have been defined for a 
particular Claim Year and whether or not a particular BOCES has been selected to participate in one or more 
projects. 

 

To access the Claim Verification Project List, follow these steps: 

 

1. Choose the Claim Year in the application header for which you want to view the Claim Verification 
Project List for and then click on the SET VALUES button. 

 

2. In the BOCES SAMS application navigate to Claim Verifications > Claim Verification Project List from the 
main menu.  The “Claim Verification Project List” screen will appear. 

 

The user is presented with a list of all the Claim Verification projects that have been assigned to the 
selected year.  The “Project Name”, “Project Description”, and “BOCES Action Required?” columns 
are displayed for the list.  The “BOCES Action Required?” column displays a “Yes” or “No” to indicate 
if the selected BOCES is required to participate in the Claim Verification process for this project in the 
selected year. 

 

Note: The CV process usually begins some time in January or February. Claim verification project information 
will not be available to you in BOCES SAMS until that time. You will receive email notification when the CV 
material has been added to the BOCES SAMS menu choices. 
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10.3 Acknowledge Receipt of the Claim Verification ‘Intent to Review’ 
Notice 

BOCES who have been selected to participate the Claim Verification process are required to acknowledge 
their receipt of the ‘intent to review’ notice that they will receive via email when SED initiates the Claim 
Verification process for a particular year.  This acknowledgement must be performed for each Claim 
Verification project in which your BOCES has been selected  to participate. 

 

To acknowledge receipt of the Claim Verification Intent to Review Notice, follow these steps: 

1. Choose the Claim Year in the application header for which you want to view a Claim Verification 
Project Form for and then click on the SET VALUES button. 

 

2. In the BOCES SAMS application navigate to Claim Verifications > Claim Verification Project List from 
the main menu.  The “Claim Verification Project List” screen will appear. 

 

3. Click on the Project Name of the project you want to work with. 

 

If the selected BOCES is required to participate in the project, the user will see the full Claim 
Verification form.  For participating BOCES, the top of the form contains the date the BOCES was 
notified by NYSED of their intent to review, the date that any materials are due, and the date the 
BOCES acknowledged receipt of the notification of intent to review.   

 

If the BOCES has not yet acknowledged receipt of the notification of intent to review, they will be 
provided a hyperlink to perform this action.  Clicking this link will save the acknowledgement date for 
the BOCES (refer to the next step).  If the BOCES has already acknowledged receipt of the intent 
notification, the user will see the date they performed this action. 

 

If the BOCES is not required to participate, a smaller, modified version of the form is shown.  This 
smaller version only includes the project fields that are being reviewed and the project 
explanation/instructions. 
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4. Click on the hyperlink provided to acknowledge receipt of the intent notification.   
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10.4 Enter a Comment on a Claim Verification Project Form 
Claim Verification project forms are defined each year. The nature and content of the forms varies depending 
on the project. The forms provide detailed instructions to the BOCES. Usually CV project forms contain 
requests for supplemental documentation of  elected State Aid claim data that was submitted earlier in the 
year. for use in tracking the process of verifying the accuracy of specified data that has been certified and 
submitted by BOCES.  BOCES users are able to enter comments on these forms. 

 

To enter a comment on a Claim Verification Project Form, follow these steps: 

1. Choose the Claim Year in the application header for which you want to view a Claim Verification 
Project Form for and then click on the SET VALUES button. 

 

2. In the SAMS application navigate to Claim Verifications > Claim Verification Project List from the 
main menu.  The “Claim Verification Project List” screen will appear. 

 

3. Click on the Project Name of the project you want to work with. 

 

If the selected BOCES is required to participate in the project, the user will see the full Claim 
Verification form.  For participating BOCES, the top of the form contains the date the BOCES was 
notified by SED of their intent to review, the date that any materials are due, and the date the BOCES 
acknowledged receipt of the notification of intent to review.  If the user is a BOCES user and has not 
yet acknowledged receipt of the notification of intent to review, they will get a hyperlink saying 
“BOCES, Click here to acknowledge receipt of notification of intent.”  Clicking this link will save the 
acknowledgement date for the BOCES.  If the BOCES has acknowledged, the user will see the date 
they performed this action. 

 

If the BOCES is not required to participate, a smaller, modified version of the form is shown.  This 
smaller version only includes the project fields that are being reviewed and the project 
explanation/instructions.  Comments cannot be entered on a Claim Verification form for a project by 
any BOCES that has not been selected to participate in that project The purpose of this version of the 
form is to make BOCES aware of the CV projects being conducted and the type of documentation 
that they might be required to submit in another year if they are selected to participate. 
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4. To add a new comment, the user will type the comment details into the text area labeled “New 
Comment” and press the “Save Comments” button.  Comments show on the form in descending 
order of created date. 

 

5. A helpful link labeled Status Descriptions is provided which will display all statuses for this project 
with their corresponding descriptions. 

 

6. At the bottom of the screen, the user will see the history of statuses that the project has gone 
through, along with notices that were sent as a result.  This list is ordered in ascending order.  
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10.5 Review the Claim Verification Activity Log 
BOCES SAMS automatically generates Claim Verification Activity Log records when certain Claim Verification 
events occur.  Users can review and filter these activity records. 

 

To review the Claim Verification Activity Log, follow these steps: 

1. In the SAMS application, navigate to Claim Verifications > Claim Verification Activity Log from the 
main menu.  This screen will show a default activity log filtered only by Claim Year and BOCES 
Name/BEDS Code set in the header of the application. 

 

2. Users can choose a variety of filter options to narrow the scope of the list. 

a. Project List – Filters by a specific project. 

b. CV Activity Type – Filters by correspondence, due date, notice, or status date. 

c. Date Range – Start and end dates used to narrow the displayed results based on comparison 
against the Date of each activity. 

 

3. After selecting filter options, click the “Apply Filter” button to apply the filter options. 

 

Note:  The log has the ability to sort all columns by clicking the column name, which is a hyperlink.  The 
default sort is by Date, descending.  Clicking a column that is already the sorted column will change the 
direction of the sort (e.g. from descending to ascending).  If an activity is a correspondence, the activity type 
will show as a hyperlink.  Clicking this link will show the details of the correspondence that is tied to this 
activity.  
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10.6 Claim Verification Statuses  
Claim Verification projects achieve various statuses as they are processed through BOCES SAMS. These 
statuses are used to control workflow-type activities.  A summary of the Claim Verification statuses is 
provided in the table below. The statuses are listed in the order in which they are achieved as a CV Project is 
processed through BOCES SAMS. 

 

Status Description 

Project Initiated Represents the status when the initial Claim 
Verification notice is sent to a BOCES.  

Project Acknowledged Represents the status when a BOCES acknowledges 
their participation in the Claim Verification project. 

Submission Received Represents the status when a BOCES has submitted 
materials for their Claim Verficiation project.  This 
status will be set when initial materials are 
submitted and when any follow up materials are 
submitted.  

Material Sufficient  Represents the status when the materials 
submitted by a BOCES are sufficient enough for 
SED to proceed with the Claim Verification.  

Materials Insufficient Represents the status when the materials 
submitted by a BOCES are not sufficient enough for 
SED to proceed with the Claim Verification.  

Revision Requested Represents the status when SED is requesting a 
BOCES to revise some of their data in BOCES SAMS 
based on SED’s review of the  Claim Verification 
project.  

Revisions Completed Represents the status when a BOCES has finished 
revising the data in BOCES SAMS that SED has 
requested.  

Project Completed  Represents the status when SED has reviewed all 
the items for the Claim Verification Project and all 
requirements have been met.  

 



BOCES SAMS Training Manual for BOCES Users (Updated April 2020) 

Page 79 of 103 

10.7 Claim Verification Notifications 
Claim Verification notifications are sent to the BOCES  State Aid Designee when a CV Project achieves various 
statuses. These notifications provide you with information about where your Claim Verification project is in 
the review process and whether or not more information is needed from you. A summary of the Claim 
Verification notifications is provided in the table below. The notifications are listed in the order in which they 
are sent as a CV Project is processed through BOCES SAMS.  

 

Notice  Description  Current Status  

Initial Claim Verification Notification This notice is sent when a BOCES has been 
selected to participate in the current years 
Claim Verification process.  

Project Initiated  

Acknowledgement Reminder This notice is sent when a BOCES has 
failed to acknowledge the Claim 
Verification Notice by the due date. The 
due date for acknowledging the Claim 
Verification is included in the Initial Claim 
Verification notification.  

Project Initiated  

No Material Received  This notice is sent when a BOCES has 
acknowledged the Claim Verification 
Notice, but has failed to submit their 
materials by the due date. The due date 
for submitting the materials is included in 
the Initial Claim Verification notification.  

Project Acknowledged  

Better Documentation Request  This notice is sent when SED needs more 
or better documentation from a BOCES 
before they can proceed with the Claim 
Verification. This notice is sent when a 
BOCES’ initial submission of 
documentation is insufficient.  

Materials Insufficient 
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Notice  Description  Current Status  

Reminder: Supplementary 
Information Needed 

This notice is sent when SED needs more 
or better documentation from a BOCES 
before they can proceed with the Claim 
Verification. The due date for submitting 
the additional documentation is included 
in the Better Documentation Request 
notification.  

Materials Insufficient  

Follow up Documentation Received 
Insufficient 

This notice is sent when SED needs more 
or better documentation from a BOCES 
before they can proceed with the Claim 
Verification. This notice is sent when a 
BOCES has resubmitted documentation in 
response to SED’s request and the 
documentation is still insufficient.  

Materials Insufficient  

Revision Request This notice is sent when SED has reviewed 
the Claim Verification project and 
determined that a BOCES needs to revise 
some of their data in BOCES SAMS.  

Revision Requested  

Reminder: Request for revision This notice is sent when a BOCES fails to 
make the revisions that SED requested by 
the due date. The due date for making the 
revisions is included in the Revision 
Request Notification.  

Revision Requested 

Project Completion This notice is sent when SED has 
completed review of the Claim Verification 
Project and all requirements have been 
met.  

Project Completed 
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Unit 11: 
Output Reports 

 

 

 

11.1 Unit Overview 
 

In this unit you will learn about viewing and printing Output Reports.  These reports are used to display 
BOCES data by PSN and CoSer Group.   
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11.2 View or Print Output Reports from SAMS 
To view or print an Output Report within SAMS, follow these steps: 

 

1. Select the Claim Year in the application header for which you want to view the Output Report and 
then click on the SET VALUES button. 

 

2. In the SAMS application navigate to BOCES Financial > State Aid Reports > BOCES Component 
Reports > Component School District BOCES Aid - Service Area Level from the main menu.   

 

The Output Report selection screen will appear.  The reports available in the tree are based on the 
Claim Year that is set in the application header. 

 

3. Select a Data Area and Data Version Date. 

 

The Data Area selection specifies which Data Area the report will retrieve data from and the Data 
Version Date selection determines what version of data the report will retrieve.  See the “About 
Data Areas” section in this manual for more information about Data Areas. 

 

The Data Version Date (if available) allows a user to select a version of the report as it existed at a 
selected point in time.  This option is useful for comparing aid calculations as of a payment or other 
snapshot date (for example – the February BOCES payment date or the November 15 frozen file used 
for aid projections) to the current report results.  The Data Version Date option is only available for 
selected dates and at different times during the annual data collection cycle (as determined by SED). 

 

4. Select a report version to view from the selection tree by clicking on it. 

 

The Output Report will be displayed and link will be available to print the Output Report.  A separate 
window will open with a printer friendly version of the Output Report after clicking on the Print 
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Form link.  Use the browser’s print functionality to print the report.  To close the newly opened 
browser window, you must click on the ‘X’ box in the upper right hand corner of the browser window 
or press ‘CTRL+W’ when that window is active. 

 

 

 

 

  



BOCES SAMS Training Manual for BOCES Users (Updated April 2020) 

Page 84 of 103 

11.3 View or Print Output Reports from the State Aid Public Website 
To view or print an Output Report from the State Aid public website, follow these steps: 

1. Navigate to the public URL https://eservices.nysed.gov/publicsams/ 

 

2. Select a School Year. 

 

3. Enter a BOCES Name or BEDS Code. 

 

4. Click on the Submit button.  A list of Output Reports for the given School Year and BOCES will be 
displayed as hyperlinks. 

 

5. Click on the name of a report to view it.  Use the browser’s print functionality to print the report. 

 

Notes: 

o A partial BOCES Name or BEDS Code can be entered and a list of matching BOCES will be displayed 
after clicking on the submit button.  Leave both the BOCES Name and BEDS Code blank to retrieve 
the full list of BOCES. 

o The list of publicly viewable Output Reports will only be displayed for BOCES for which BOCES SAMS 
form sets are in the CLEAN or greater data state.  

o The data displayed on output reports on the public website reflects official data in SAMS as of 
midnight the night before. To view more recent reports; e.g., reports reflecting recently accepted 
revisions, you must access the output reports from inside BOCES SAMS. 

 

  

https://eservices.nysed.gov/publicsams/
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Unit 12: 
Other Reports  

 

 

12.1 Unit Overview 
 

In this unit, you will learn about viewing and printing the other various reports available in BOCES SAMS.  

 

For a table which summarizes the location, description and suggested use of the BOCES Financial reports 
please see the following web page: 

 

  BOCES Report DEMO 

  

https://stateaid.nysed.gov/ASBO/html_docs/boces_report_demo.htm
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Beginning April 2013, BOCES SAMS reports are now under a single menu choice. 

 

Simply click on BOCES Financial to quickly access the screen below or use the BOCES Financial drop down 
menu as shown. 

 

 

 

Note:  some reports have been re-named to identify whether they are primarily expense allocation reports, 
component level or cross contract reconciliation reports (but the reports remain the same).   
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For example, what used to be refered to as “Output Reports” menu choice is now: BOCES Expense for 
Allocation (Service Area Level), SA-114, RWADA and EPE. 

 

Clicking on this menu choice brings you to the screen shown below, in which you can select either the Official 
or Revision Data Area, and choose the Data Version Date: 
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12.2 View or Print SA- 111 Schedule 4 Report 
 

This report displays data from Schedule 4.  To view or print the SA-111 Schedule 4 report, follow these steps: 

 

1. Select the Claim Year in the application header for which you want to view the report and then click 
on the SET VALUES button. 

 

2. In the BOCES SAMS application navigate to BOCES Financial > State Aid Reports > SA 111 Schedule 4 
Report from the main menu.  

 

  A screen will appear that allows you to filter the data you want to display on the report.  

 

3. Select one of the following BOCES Filters:  

a. Current BOCES (Default): This returns Schedule 4 data for the BOCES set in the application 
header.  

b. BEDS Code: This returns Schedule 4 data for the BOCES BEDS code entered on the screen. If 
this option is selected, enter the BOCES BEDS code in the box below the selection button.  

c. BOCES Name: This returns Schedule 4 data for the name of the BOCES entered on the 
screen. If this option is selected, enter the name of the BOCES in the box below the selection 
button.  

d.  All BOCES: This returns the Schedule 4 data for all BOCES 

 

4. Select one of the following filter options under the Select Filter by Option heading; 

a. PSN: This returns Schedule 4 data for the PSN entered on the screen. If this option is 
selected, enter a PSN in the box next to the selection button.   

b. Major CoSer Groups: This returns Schedule 4 data for the Major CoSer Groups that are 
selected. If this option is selected, select one or more Major CoSer Groups below the 
selection box. To select more than one Major CoSer group, hold down the CTRL button and 
make your selections from the list.  

c.  All PSNS for Selected BOCES: This returns Schedule 4 data for all PSNs for the BOCES you 
have selected.  
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d. State Activity Code: This returns Schedule 4 data for the State Activity Code entered on the 
screen. If this option is selected, enter a State Activity Code in the box next to the selection 
button.  

 

5. Select one of the following Data Versions: 

a. Actual: This returns Schedule 4 data for the current claim year.  

b. Projected: This returns Schedule 4 data for the next claim year.  

 

6. Select one of the following Data Areas:  

a. Official 

b. Revision  

 

 

7. Select one of the following Report Types:  

a. Summary 

b. Detail 

 

8.  Click on the Apply Filter Button.  

 

      The report will display data based on the filters that you have selected.  

 

9. To print the report, go to the file menu on the top of the browser and select print. A new print 
options window will open. After selecting the print options you want, click the Print button.   
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12.3 View or Print Excess Salaries for Contracted Services: Purchasing 
BOCES Report.  

 

This report displays excess salaries charged to your BOCES by the provider BOCES. To view or print the Excess 
Salaries for Contracted Services: Purchasing BOCES Report, follow these steps:  

 

1. Select the Claim Year in the application header for which you want to view the report and then click on 
the SET VALUES button. 

 

2. In the BOCES SAMS application navigate to BOCES Financial > State Aid Reports > Cross-Contract 
Reconciliation > Excess Salaries for Contracted Services: Purchasing BOCES Report from the main menu. 

 

     The report will open.  

 

3. To print the report, click on the print link on the top of the form. A new window will appear that displays 
the report. Go to the file menu option on the top of the browser, and select print. A new print options 
window will open.  After selecting the print options you want, click the Print button.  
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12.4 View or Print UAS Charges for Cross Contracted Services by 
Purchasing BOCES Report.  

 

This report displays unapproved services charged to your BOCES by provider BOCES. To view or print the UAS 
Charges for Cross Contracted Services by Purchasing BOCES Report, follow these steps: 

 

1. Select the Claim Year in the application header for which you want to view the report and then click on 
the SET VALUES button.   

 

2. In the BOCES SAMS application navigate to BOCES Financial > State Aid Reports > Cross-Contract 
Reconciliation >  UAS Charges for Cross Contracted Services: Purchasing BOCES ReportReport from the 
main menu.  

 

      The report will open in a new screen.       

 

3. To print the report, click on the print link on the top of the form. A new window will open displaying a 
“printer friendly” version of the form. Go to the file menu on the top of the new window browser, and 
select print.  A new print options window will open. After selecting the print options you want, click the 
Print button.  
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12.5 View or Print Service Expense for Allocation Report 
 

This report displays component allocation data by PSN. To view or print the Service Expense for Allocation 
report, follow these steps:  

 

1. Select the Claim Year in the application header for which you want to view the report and then click on 
the SET VALUES button.   

 

2. In the BOCES SAMS application navigate to BOCES Financial > State Aid Reports  > BOCES Expense for 
Allocation > Service Expense for Allocation Report from the main menu.  

 

     A screen will appear that allows you to select the PSN that you want view on the report.  

 

3. Begin typing the first number of the PSN you want to view in the Type PSN box. Select the PSN you want 
from the dropdown list.  

 

4. Click on the Get Report button.  

 

The report will display on the bottom of the screen for the PSN that you have selected.  

 

4. To print the report, go to the file menu on the top of the browser and select print. A new print options 
window will open. After selecting the print options you want, click the Print button.   
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Unit 13: 
Helpful Tips 

  

 

 

13.1 Unit Overview 
 

In this unit, you will learn some helpful tips for submitting your data in BOCES SAMS.  
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13.2 Helpful Tips for Submitting BOCES Financial Data  
The items listed below are tips that will help you submit your BOCES financial data in time for the November 
database.  

1. The edit report must be certified by the superintendent in order for the form set to be considered 
“received” by SED. If you think you have submitted your form set, please go to the Activity Log to verify: 
if you see that a form set says “Certified,” it has been “received” by SED. If “Certified” does not appear, it 
has not been received. 

2. When a form set is “in your court,” e.g., activity log indicates “edit rejection,” “correction rejected,” 
“revision rejected,” or “clean with issues,” you must  import revised data into the BOCES SAMS revision 
data area, , Then refer to the Edit Report, make any necessary comments and “SAVE THE COMMENTS.” 
To submit the revisions/comments back to SED, you must select the Change Submission form and click 
the Submit button. You must repeat this process for each form set for which changes are being 
submitted.  

3. After certifying, please ensure that the activity log show “certified”. 

4. After certifying, please check the activity log and your email for “edit rejection” by SED staff. BOCES 
SAMS will not allow SED staff to operate on the form set if it is “in your court.” Therefore, we cannot 
“clean” your form set for inclusion in the November frozen file if you do not submit corrections in 
response to SED “edit rejection.” Similarly, if you have submitted a correction in response to an SED edit 
rejection, it is possible that you have subsequently received a “correction rejected” notice from SED. 
Again, we cannot “clean” your form set for inclusion in the November frozen file if you do not submit 
another correction. 

5. Until November 1st, acceptable corrections (before form set has been cleaned by SED) and revisions 
(after form set has been cleaned by SED) are guaranteed to be included in the November frozen data file. 
After submitting a correction or revision, please check the activity log and your email for possible 
rejection notification by SED staff. Again, SAMS will not allow SED staff to operate on the form set if it is 
“in your court.” Therefore, we cannot accept your correction/revision into the November frozen data file 
if you do not re-submit changes that have been rejected by SED staff.  

6. To avoid edit rejection, correction rejection and revision rejection by SED edit staff, please run the edit 
reports and address any edit exceptions prior to submission by changing the data or providing a 
substantive and reasonable explanation.  
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Unit 14:  
Facility Form Set 

 

 

 

14.1 Unit Overview 
This section is to go over the claims process for the Facility Form Set which includes the Sa-109 and Sa-116a 
forms. 

Rent and Capital Aid is calculated based solely on allocated rent and capital expenses submitted in the SAMS 
State Aid claim form Project costs, bond information, leases, SA-109, SA-116 etc, submitted to SED, affect the 
amounts that should be entered in the SAMS allocated rent and capital areas, but only the actual SAMS aid 
claim expenses determine rent and capital aid. 

 

PLEASE NOTE: THIS FORM IS ONLY AVAILABLE IN THE OFFICAL 
DATA AREA AND MAY ONLY BE SUBMITTED ONCE. 
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14.2 Sa-109 
 

14.2.1 Synopsis 
 

The Sa-109 is the capital claim form which breaks the capital claim out by either project number or bond. If a 
Sa-109 is not received by June 30th of claim year then aid on the capital claim will not be paid by State Aid. 

 

For a capital project to be aided in a claim year, the contract must be signed and a SA-139 must be submitted 
by June 30th of the claim year (and the contract must be signed after the Commissioner’s Approval Date 
(CAD) Capital expenses may be claimed in SAMS before the contract is signed, but this should only be done if 
you are quite certain the contract will be signed by June 30th of the aid year 

 

In addition to components’ actual debt service expense, the amount claimed in SAMS can be the component 
expense paid to the BOCES for actual or anticipated BOCES project expenditures.  However, under no 
circumstances will aid be paid to reimburse components for actual or anticipated project expense paid to the 
BOCES if no SA-139 is received by June 30th of the aid year even if components have paid the BOCES during 
the aid year. 
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14.2.2 Claim Process 
 

The data entry form is available once the BOCES SAMS is released for the year and can filled out at any time 
during the school year. The steps are as follows:  

1. Click on the Summary of Building Payments  

 
 

2. Click on either create new button depending on what type of building project it is 
a. Bonds are for the projects that are either funded through DASNY, one or more component 

issued bonds for the funding, or an EPC. (Step 3) 
b. Capital Projects are the projects where ALL of your components are paying cash for the 

project (Step 4) 
 

 
 

3. BONDS - Enter the information that is requested. 
a. Bond type is either DASNY or Multiple 
b. The Total Amount of the Financed Cost 

i. From the Sa-132 
c. Approved Financed Cost  

i. From the Sa-130 
ii. The difference from b and c are if there are portions for the building projects that 

are deemed non-aidable by the Office of Facilities Planning.  
d. Bond Percent which is the current aidable amount 
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i. This does change during the project and will only be final once ALL of the Final Cost 
Reports have been received and processed. 

e. The Component Information  
i. How much the component paid that year for the bond 

f. Notes 
i. If you have any information that you think State Aid should know about the bond at 

the time you are entering/submitting the Sa-109 it is to be entered here. 
 

4. CAPITAL - Enter the information that is requested. 
a. Project Number 
b. Total Project Cost to be Funded from District Appropriations or Capital Reserves 
c. Total Approved Cost from District Appropriations or Reserves 

i. Total Aidable Amount on the SA-130 
ii. The difference from b and c are if there are portions for the building projects that 

are deemed non-aidable by the Office of Facilities Planning.  
d. The Component Information  

i. How much the component paid that year for the bond 
e. Notes 

i. If you have any information that you think State Aid should know about the capital 
project at the time you are entering/submitting the Sa-109 it is to be entered here. 
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5. Once all the project information is entered and saved it will appear on the Summary Page 
 

 
 

6. After all the Projects and Bonds are entered you can ready the entries. 
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14.3 Sa-116A 

14.3.1 Synopsis 
 

The purpose of the SA-116 is to determine the exact amount of aidable  rent expense that can be claimed for 
an aid year. By the end of the aid year, the allocated rent amounts on the SED-approved SA-116 and the 
allocated rent amounts in SAMS must be equal. SED reviews the SA-116, and then advises the BOCES 
whether a SAMS revision should be submitted to reflect the actual SA-116 claim, or whether the SA-116 
should be revised.  

 

FOR A LEASE TO BE AIDED THE BOCES MUST HAVE AN APPROVED 
FORM A AND A COPY OF THE LEASE ON FILE WITH THE OFFICE OF 

FACILITIES PLANNING. 

  



BOCES SAMS Training Manual for BOCES Users (Updated April 2020) 

Page 101 of 103 

14.3.2 Claim Process 
 

The data entry form is available once the BOCES SAMS is released for the year and can filled out at any time 
during the school year. The steps are as follows:  

1. Click on the Summary of Rental Facilities  

 
 

2. Click on New Entry 
 

 
3. Enter the requested information 

a. Facility Address 
i. Street Number 

ii. Street Name 
iii. Street Address Line 2 (Optional) 
iv. City 
v. Zip Code 

b. Payments 
i. Gross Rental Payments 

ii. Non-Aidable Use/Revenues From Other Sources 
c. Comments 

i. If you have any information that you think State Aid should know about the lease at 
the time you are entering/submitting the Sa-109 it is to be entered here. 

4. Once all the lease information is entered and saved it will appear on the Summary Page 
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5. After all the leases are entered you can Ready the entries 
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14.4 Edit Report 
 

Once the Sa-109 and Sa-116a have completely been filled out and readied it is time to run the edit report. 

 

1. Select the Edit Exception Report you want to run from the Facility Form Tree. 

 

2. After the Edit Exception Report page loads, click on the Run Report button to run a new report. You 
must have the default setting, ‘Run New’, set in the drop down list box. (To see previously executed 
reports, select one from the drop-down list, and click on Run Report.) 

3. If you do not have any edits, you can ready the report. 

4. If you do have edits this means that the amounts on the Sa-109 and Sa-116a do not match what is in 
the SAMS capital claim. Please revise the appropriate report and rerun the edit report 

a. If a revision has been submitted to financial SAMS to eliminated the edit(s) you may 
ready the report once State Aid processes the Financial revision this edit will go away. 

5. Have your Superintendent review and Certify the Facilities Claim from the Certification Form. 

6. State Aid will then review and forward the information where appropriate.  
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